VENTURA COUNTY WATERSHED PROTECTION DISTRICT

VENTURA COUNTY MODIFIED RATIONAL METHOD PROGRAM

VENTURA COUNTY WATERSHED PROTECTION DISTRICT

VENTURA COUNTY, CALIFORNIA

JULY, 2017
### DISTRICT CONTACTS

<table>
<thead>
<tr>
<th>Role</th>
<th>Name</th>
<th>Position</th>
<th>Division</th>
</tr>
</thead>
<tbody>
<tr>
<td>District Director</td>
<td>Glenn Shephard</td>
<td>Watershed Protection District</td>
<td></td>
</tr>
<tr>
<td>Division Manager</td>
<td>Bruce Rindahl</td>
<td>Manager, Watershed Resources and Technology Division</td>
<td></td>
</tr>
<tr>
<td>Design Hydrologist</td>
<td>Mark Bandurraga</td>
<td>Engineer IV, Hydrology Section</td>
<td></td>
</tr>
<tr>
<td>VCRat Programmer</td>
<td>Scott Holder</td>
<td>Hydrologist IV, Hydrology Section</td>
<td></td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

## Section 1
**Introduction**

1.1 Purpose and Scope ................................................................. 1-1

1.2 Model Assumptions and Limitations .................................................. 1-1

## Section 2
**VCRat Input Data** ........................................................................ 2-1

2.1 Subarea Maps ........................................................................... 2-1

   Figure 1. Calleguas Subarea Map with Flow Arrows ................... 2-2

   Table 1. Calleguas Model Subarea Flow Output with Confluences .... 2-3

   2.1.1 Subarea Channel Routing .................................................... 2-3

2.2 Subarea Soil Types ..................................................................... 2-3

2.3 Rain Zones and Design Storm Levels ................................................ 2-4

   Figure 2. VCRat2.2 and 2.6 Rainfall Zone Map with Jurisdictional Channels ..... 2-4

2.4 Time of Concentration Tc ................................................................ 2-5

   Figure 3. VCRat2.64 Rainfall Zone Map ...................................... 2-5

2.5 Percent Imperviousness .................................................................. 2-5

2.6 Flow Splits ............................................................................... 2-6

2.7 Detention Basin Info ..................................................................... 2-6

2.8 Hydrograph Yield Adjustment ........................................................ 2-6

2.9 Areal Reduction .......................................................................... 2-7

2.10 Sediment Yield and Bulking Factor ............................................... 2-8

2.11 Mitigation Criteria ..................................................................... 2-8

## Section 3
**VCRat Spreadsheet** .................................................................... 3-1

   Figure 4. Iterative Calculation Setup for VCRat Spreadsheet .......... 3-1

   Figure 5. VCRat Spreadsheet Data Input and Results Section .......... 3-2

   Figure 6. Basin Hydrograph Routing Results .................................... 3-3

## Section 4
**VCRat2.64 Model Preparation** ...................................................... 4-1

   Figure 7. VCRat2.64 Initial Window .............................................. 4-1

   4.1 Project Info Window .................................................................. 4-1

   Figure 8. Project Info Page with Legacy C Coefficients and Rainfall Zones Selected .................................................. 4-2
## TABLE OF CONTENTS

Figure 9. Partial Project Info Window with Revised C Coefficients Selected........ 4-3

4.1.1 Tools→Options Window .............................................................................. 4-3

Figure 10. Options Window .................................................................................. 4-3

4.2 Subarea Editing Window .................................................................................. 4-4

Figure 11. New Model Command/Operation Window ........................................... 4-4

Figure 12. Partial Model Operation Subarea Window ........................................... 4-4

Figure 13. Subarea Editing Window ...................................................................... 4-5

4.2.1 Channel Routing .......................................................................................... 4-5

Figure 14. Channel Routing Window and Channel Dropdown Menu .................... 4-6

Figure 15. Rect/Trap Routing Window with Limits .............................................. 4-6

Table 2. Channel Routing Parameters ................................................................... 4-7

4.2.2 Use of Placeholders .................................................................................... 4-7

4.2.3 Detention Basin Routing ............................................................................. 4-7

Figure 16. Detention Basin Routing with Fattening .............................................. 4-8

Figure 17. Subarea Window with Post-Basin Routing ........................................... 4-8

4.2.4 Confluences .................................................................................................. 4-9

Figure 18. Partial Confluence Editing Window with Hydrograph and Confluence Options ............................................................................................................. 4-9

4.2.5 Diversions ................................................................................................... 4-9

Figure 19. Partial Diversion Editing Window Showing Options ............................. 4-9

4.2.6 Areal Reduction Simulations ....................................................................... 4-10

Figure 20. Partial Model Editing Window for Areal Reduction Example................. 4-10

4.3 VCRat Output ................................................................................................... 4-11

Figure 21. Partial VCRat2.64 Output File ............................................................. 4-12

### Section 5 Design Procedures And Topics ........................................................................... 5-1

5.1 Updated MPD Data .......................................................................................... 5-1

5.2 Unit Runoff Calculations for Small Projects ..................................................... 5-1

5.3 Design Storm Multipliers ................................................................................ 5-2

5.4 Time of Concentration Calculations .................................................................. 5-2

5.5 Bulking Factors ................................................................................................ 5-2

5.6 Change in Runoff Parameters due to Fire ......................................................... 5-2
TABLE OF CONTENTS

5.7 Flow Limitation Agreements, City of Oxnard.......................................................5-2
5.8 Bypass Basin Design .............................................................................................5-3
5.9 Flow-Through Basin Design..................................................................................5-3
5.10 Simplified Basin Design Procedures for Small Projects........................................5-3
  5.10.1 100-Yr Undeveloped Condition Peak Mitigation .....................................5-3
  5.10.2 10-Yr Developed Peak Mitigation Criteria...............................................5-4
Table 3. Simplified Basin Based on Impervious Area...........................................5-4
Table 4. Simplified Basin Volume Based on Storm Depth - .................................5-5
  5.10.3 VCRat Hydrographs for Small Projects....................................................5-5

Section 6  References ......................................................................................................6-1
<table>
<thead>
<tr>
<th>Acronym</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>ac.</td>
<td>Acres</td>
</tr>
<tr>
<td>ASCE</td>
<td>American Society of Civil Engineers</td>
</tr>
<tr>
<td>cfs</td>
<td>Cubic feet per second</td>
</tr>
<tr>
<td>cy</td>
<td>cubic yards</td>
</tr>
<tr>
<td>District</td>
<td>Ventura County Watershed Protection District</td>
</tr>
<tr>
<td>EPA</td>
<td>Environmental Protection Agency</td>
</tr>
<tr>
<td>FEMA</td>
<td>Federal Emergency Management Agency</td>
</tr>
<tr>
<td>fps</td>
<td>Feet per second</td>
</tr>
<tr>
<td>Ft</td>
<td>Feet</td>
</tr>
<tr>
<td>HEC</td>
<td>USACE Hydrologic Engineering Center</td>
</tr>
<tr>
<td>HEC-HMS</td>
<td>Hydrologic Modeling System</td>
</tr>
<tr>
<td>HEC-RAS</td>
<td>River Analysis System</td>
</tr>
<tr>
<td>HSPF</td>
<td>Hydrologic Simulation Program- Fortran</td>
</tr>
<tr>
<td>in.</td>
<td>Inches</td>
</tr>
<tr>
<td>mg/l</td>
<td>milligrams/liter</td>
</tr>
<tr>
<td>mi.</td>
<td>Miles</td>
</tr>
<tr>
<td>NOAA</td>
<td>National Oceanic and Atmospheric Administration</td>
</tr>
<tr>
<td>NRCS</td>
<td>Natural Resources Conservation Service</td>
</tr>
<tr>
<td>SCS</td>
<td>Soil Conservation Service</td>
</tr>
<tr>
<td>sq. mi.</td>
<td>Square miles</td>
</tr>
<tr>
<td>Tc</td>
<td>Time of Concentration</td>
</tr>
<tr>
<td>USACE</td>
<td>U.S. Army Corps of Engineers</td>
</tr>
<tr>
<td>USBR</td>
<td>U. S. Bureau of Reclamation</td>
</tr>
<tr>
<td>USGS</td>
<td>U. S. Geological Survey</td>
</tr>
<tr>
<td>VCRat</td>
<td>Ventura County Modified Rational Method Model</td>
</tr>
<tr>
<td>VCWPDP</td>
<td>Ventura County Watershed Protection District</td>
</tr>
<tr>
<td>Vw</td>
<td>Wave velocity</td>
</tr>
</tbody>
</table>
SECTION 1 INTRODUCTION

1.1 PURPOSE AND SCOPE

This User Manual presents guidelines and sufficient input data for using the Ventura County Watershed Protection District’s (VCPWD or District) modified rational methods in design hydrology studies in Ventura County. The programs provided by the District include Ventura County Rational for 64-bit computers (VCRat2.64) which can simulate the runoff from 10,000 subareas and operations, and an Excel spreadsheet. The spreadsheet can calculate the runoff from one subarea and route it through a flow-through detention basin or calculate the required volume of a bypass basin. The required Time of Concentration used as input to the VCRat models is generated with the TcCalc program or the Tc Calculator spreadsheet summarized in a different manual.

VCRat is used for projects subject to District’s requirements. This Manual is intended to supplement the 2017 Design Hydrology Manual which contains a complete description of the hydrology methods used by the District. However, the modified rational method continues to be used in most of the design hydrology studies submitted for review. To make it easier for consultants to become proficient in the use of this method, this User Manual was prepared.

1.2 MODEL ASSUMPTIONS AND LIMITATIONS

The VCRat method has the following assumptions and limitations:

1. Limited to partially- to completely-urbanized watersheds of less than 5,000 ac.
2. Subareas ranging from 5 to 300 ac with Tc’s ranging from 5 – 30 minutes. For smaller projects, results from a larger subarea can be pro-rated or calculated with the VCRat spreadsheet.
3. VCRat2.64 program is limited to integer subarea sizes, Tc’s, percent imperviousnesses, and soil types. The VCRat spreadsheet uses integer Tc’s, soil types, and percent imperviousness.
4. The conceptual model assumes that inflow from an upstream subarea is routed through the downstream subarea channel and then combined with the local runoff from the downstream subarea.
5. Channel and detention basin routing uses the Modified Puls method. Channel routing bases the travel time on wave velocity.
6. VCRat hydrographs in volume-critical analyses are adjusted to make the yields match the NRCS Curve Number yields assuming Antecedent Moisture Condition II.
7. Peaks and hydrographs for watersheds greater than 640 acres total are areally reduced based on the assumption that storm cells generating the highest intensity rainfall are about 1 sq mi in size. The factors used to reduce the design rain intensities based on the size of the watershed are embedded in the VCRat2.64 program.
8. Assumes that the drainage system can accept the runoff with open channel conditions.

In some cases, historic models contain subarea sizes and Tc’s that violate the above current limits. VCRat2.64 has a feature that will allow you to run these historic models but cannot be used to edit them.
SECTION 2  VCRAT INPUT DATA

The modified rational method requires the following input data: subarea size, Tc, weighted average soil type, rainfall zone, percent imperviousness, channel type and routing information, and any flow diversion or detention basin information that applies.

2.1 SUBAREA MAPS

VCRat requires the development hydrology maps with delineated subareas for existing and proposed conditions. Existing condition subareas in undeveloped areas are delineated based on topography and subject to the 5 to 300 acre range used in the VCRat2.64 model. Subareas may have to be modified if their resultant Tc’s do not fall into the 5 to 30 minute range used in VCRat.

Developed condition subareas are delineated based on a combination of topography, flow obstructions and diversions, and drainage inlets which may convey flow across topographical divides. Subarea boundaries are generally drawn assuming relatively low flow conditions without trying to account for breakouts that can occur during the larger design storms. Based on this, subarea runoff is assumed to stay in a gutter without considering the complexity of flooded streets at higher flows that could cause the flow to overtop the crown of a street and cross into another subarea.

Subareas are labeled with a number followed by a letter. The number is applied in ascending order from upstream to downstream with the most upstream subarea having the lowest number. The numbers usually start with 1 but can also start at a higher number if desired. The largest number that can be used is 9999. The letter represents one of the six (A through F) storm drain lines to convey flow that can be used in a model. The lines are used to represent flow in unimproved channels, streets, closed storm drains, and open channels or some combination of the four.

The main channel in a watershed is usually the A line and the other lateral lines (B, C, D, E, F) confluence with it. Once lateral line flow is combined with mainline flow, it can be re-used to represent another lateral line rather than having to use another letter. Any of the lateral letters can be used to represent the next lateral, they do not have to be used in order. The flexibility is provided to allow the user to label their subarea map to clearly show how the flow progresses through the watershed. An example of subarea labeling is shown in Figure 1.

Confluences in the model can be of two types- implicit and explicit. An implicit confluence is when subarea flow is added to the flow on the mainline. In the example from the District’s official Calleguas model in Table 1, 186B is added to the flow from 185B. An explicit confluence is when the next subarea is given a lateral letter and then the program confluences the mainline with the lateral, such as when the flow from 186B is combined with the flow from 192C at location 193BC.

Subareas sizes used in the VCRat2.64 model are integers. The VCRat spreadsheet accepts decimal subarea sizes.
Figure 1. Calleguas Subarea Map with Flow Arrows
### 2.1.1 Subarea Channel Routing

The conceptual model in the VCRat program is that flow from an upstream subarea like 185B is routed through the channel in the next subarea such as 186B before being combined with the local runoff from 186B. If the channel type is known, (street, pipe, open rectangular or trapezoidal channel), it can be specified along with the dimensions (diameter, width, sideslope), length, and slope. If the diameter or width is not specified, the program will select the appropriate channel type based on the flow level. The program has a default n value of 0.012 for closed concrete finished channels. N values can be specified for open rectangular or trapezoidal channels if the default value of 0.014 for concrete is not appropriate.

Different combination of dimensions and channel types can cause unrealistic results as summarized in the Hydrology Manual. The most common problem occurs when a pipe size is specified that is too small for the given flow level. The program will then force the flow through the pipe under pressure, resulting in travel times for that reach that are unrealistically short. Because many City storm drains are designed for the 10-yr storm peak, entering the conduit sizes in the VCRat input can lead to pressure flow at the 100-yr level. Therefore, it is common to leave the conduit sizes unspecified in VCRat runs.

### 2.2 Subarea Soil Types

The soil types in the VCRat program are represented by the District’s seven soil categories. These categories add an additional level of refinement to the NRCS’s four hydrologic soil classes of A, B, C, and D. For the District, an increasing number represents higher infiltration rates. District Soil 1 represents the NRCS’s D type for clayey soils with the lowest infiltration rate.

The soil type for a project area is generally obtained through GIS or AutoCAD analysis using the soil shapefiles provided with the Hydrology Manual downloaded from the District’s website. If more than one soil type is present, a weighted average soil type is calculated and then rounded to the nearest whole number. Only whole number soil types are used in VCRat.
2.3 Rain Zones and Design Storm Levels

VCRat2.6 and previous versions of the program used four main rain zones (J, J’, K, and L) to represent design storm rainfall across the County as shown in Figure 2. Of those zones, the K zone was most common in areas of development. VCRat2.64 was updated to use the design storm rainfall published in NOAA’s 2011 update of Atlas 14 Volume 6. The NOAA gridded intensity results were evaluated based on watershed boundaries. As shown in Figure 3, 31 watersheds were used to group similar design storm intensity data for use in the VCRat program. The correct zone for use in an analysis is determined by overlaying the rain zone shapefile on a map of the project area. The rain zone shapefile is provided with the Hydrology Manual on the District’s website at http://vcpublicworks.org/watershed-resources-and-technology/hydrology-manual-2. A map of the rain zones is provided in the 2017 Hydrology Manual or at: http://vcwatershed.net/publicMaps/data/.

The VCRat program is currently set up to analyze the 10-, 25-, 50-, or 100-yr storms. The rainfall distributions for other storm levels have not been generated. If the District’s Permits Section specifies that the developed condition peak should not exceed the existing condition peak at every storm frequency, they are referring to those four levels.

![Figure 2. VCRat2.2 and 2.6 Rainfall Zone Map with Jurisdictional Channels](image-url)
2.4 TIME OF CONCENTRATION Tc

The time of concentration for a subarea is obtained with the Tc Calculator program or the Tc Calculator spreadsheet. When Tc’s were done with hand calculations only 25% of them were actually calculated and the rest were assigned based on engineering judgment. Because the calculations are now easier, the District currently requires that 75% of the developed subareas and 25% of undeveloped areas have calculated Tc’s. The remaining subareas can have Tc’s assigned to them through engineering judgment based on subareas with similar development and runoff characteristics. The Tc Calculator program is bundled with the VCRat2.64 package available from the District’s website with the 2017 Hydrology Manual. The Tc Spreadsheet is included in Appendix E of the Hydrology Manual.

Figure 3. VCRat2.64 Rainfall Zone Map

2.5 PERCENT IMPERVIOUSNESS

VCRat2.6 and previous versions of the program had relatively high C coefficients used in the rational method calculations. Because of this, the District recommended that an effective impervious value be used if any of the runoff from impervious surfaces (roofs, patios, driveways, sidewalks) was routed across
a pervious surface. This assumption reduced the model impervious value of a low density residential
development with 1/5 ac lots from 47 to 23%.

For VCRat2.64, the C coefficients have been calibrated based on existing stream flow measurements and
comparison with values used by nationally known agencies. The decrease in C coefficient values from
this process in combination with larger buildings with less pervious area constructed currently requires
the user to include the actual imperviousness in the model run to get reasonable results. The
recommended percent imperviousness for different types of development are available from Hydrology
Manual Exhibit 14. If the reference values in Exhibit 14 do not appear to accurately reflect the
imperviousness of a project site, the imperviousness should be calculated and used in the VCRat
calculations.

2.6 FLOW SPLITS

VCRat contains some simplified methods to divert flow in a channel into a lateral drain. The main use of
this feature is to model a bypass basin intended to accept flow in order to meet a mitigation goal for a
development (flow above a specified level is diverted to a relief drain or basin with a side channel weir).
Other diversion options are intended to model flow obstructions or hydraulic structures that divert a
varying portion of the flow into a relief drain depending on the flow level. The diversion options are
explained in more detail in the Hydrology Manual. VCRat is not considered to be an appropriate model
to use in evaluating the effect of flow obstructions on peak flows. In those cases, a hydraulic model
should be used.

2.7 DETENTION BASIN INFO

VCRat can route flow through a detention basin using the Modified Puls Method. The user must
calculate the stage storage discharge data points and enter them into the program. An alternate use of the
VCRat program is to export the calculated watershed hydrograph to another program that will do the
basin routing. This is done because some of the programs have automatic design features that reduce the
iterative process of designing the basin and routing the hydrograph through it to see if it meets the
District’s operating criteria. General operating criteria include 1-ft of freeboard above the 100-yr water
surface to the emergency spillway invert, 3 ft of freeboard above the emergency spillway water surface if
the operating outlet is blocked, and a maximum drain time of 24 hours from the time of peak storage
during a storm.

2.8 HYDROGRAPH YIELD ADJUSTMENT

The hydrographs used for detention basin design or floodplain analysis are yield adjusted to ensure that
they have reasonable volumes. VCRat hydrographs generally have lower volumes that are obtained from
an NRCS Curve Number (CN) analysis of a watershed. Therefore, the yield adjustment generally adds
volume to the VCRat hydrograph except for watersheds with high percents imperviousness. This process
has historically been called “fattening” the hydrograph.

The yield adjustment is done by following the NRCS guidelines to calculate a weighted average CN
based on the soil and development types in a watershed. The Antecedent Moisture Condition II (AMC II)
CN is then used to calculate a watershed yield assuming that the Initial Abstraction is 0.2*S where S is the potential maximum retention. The result is then entered into the VCRat program reservoir routing input window which initiates a routine to increase the hydrograph volume to match the CN yield. The algorithm is designed to add volume without increasing the hydrograph peak and provide a hydrograph with a reasonable shape.

CNs for use in calculating the yield based on the District’s soil types are provided in Exhibit 14 of the Hydrology Manual. For undeveloped areas with mostly natural vegetation, the District usually uses the CNs associated with the open brush in fair hydrologic condition classification. AMC II CNs provide reasonable yields for County watersheds based on evaluations of historic storm runoff, even at the 50- and 100-yr levels.

Complexities associated with yield adjustment are discussed in detail in the Hydrology Manual. These include how to fatten hydrographs in watersheds downstream of detention basins where the flow has already been fattened.

### 2.9 Areal Reduction

Because the storm cells providing the most intense rainfall are up to about 1 sq mi in size, the rainfall intensities over a watershed larger than 1 sq mi are reduced due to spatial effects. Therefore, the corresponding hydrograph peaks are areally-reduced. The areal reduction factor (ARF) for a 600-ac watershed is 1.0, and varies linearly from 600-640 ac to the calculated ARF for 640 ac. Above 640 ac, the program calculates the areally-reduced flow peak for use in design.

Areal reduction is done by specifying the model node where you want the peak reduced in the VCRat2.2 input file. Each location that requires a design peak has to be analyzed with a separate run. The program then uses factors embedded in the program to reduce the peak intensities based on the tributary area to the specified location and calculates an areally-reduced peak.

VCRat2.64 and VCRat2.6 do not currently have the capability of providing areal reduction results directly. However, the output files for those programs append the VCRat2.2 format input files. The VCRat2.2 input files can be edited to add the data necessary for obtaining areal reduction results, and then the “Run VCRat2.2 File” option in the VCRat2.6 and 2.64 programs can be used to obtain areally-reduced results.

The Hydrology Manual contains a detailed discussion of the complexities of obtaining areal reduction results. These include the fact that VCRat cannot calculate areal reduction results if the file contains a basin routing section. Therefore, the basin outflow hydrograph has to be exported and the basin watershed subareas replaced by a hydrograph import operation. To obtain an AR peak downstream of the basin, an ARF is calculated for the net tributary area. Areal reduction can be applied to a net tributary area downstream of the basin of less than 600 ac because the total watershed including the basin is larger than 640 ac and therefore is subject to spatial effects.
**SECTION TWO**

**2.10 SEDIMENT YIELD AND BULKING FACTOR**

Hydrology design studies are not generally required to apply a bulking factor to the design hydrograph unless one of the following applies:

1. Watershed is a known high-sediment producer based on historical observations.
2. Channel design is to protect critical infrastructure such as a school or hospital.
3. Design is for an emergency project after a fire in the watershed.

If the project is in one of those categories, the calculation of sediment yield volumes and application of bulking factors to hydrographs will be required on a case by case basis by the Permits Section. The District’s sediment yield calculation procedures are discussed in the Basin Manual and the use of the results to develop a bulking factor is presented in the Hydrology Manual.

**2.11 MITIGATION CRITERIA**

The mitigation criteria for projects in the unincorporated County is that the developed condition peak cannot exceed the existing condition peak for any of the four design storm levels. For incorporated cities where the project will not have a direct connection to one of the District’s jurisdictional channels, the mitigation criterion is generally that the 100-yr developed condition peak has to be limited to the 10-yr developed condition peak. If the project will use or create a direct connection to one of the jurisdictional channels, the County’s requirements also apply and the developer will have to obtain a permit from the District.

Most cities require their storm drain infrastructure to be designed to convey the 10-yr storm, with flow above that level being contained in the streets without flooding the adjacent development. The City of Moorpark has used a 50-yr local drainage design level in the past.

Most cities require the use of the VCRat model for design of storm drain systems. The City of Oxnard uses the Cook’s Method for their local storm drain design. But because the Cook’s Method does not provide a way to evaluate detention basins, Oxnard requires that VCRat be used for this purpose.

The appropriate mitigation criteria and program should be verified with the permitting agency or agencies prior to starting the design process for a project.
SECTION 3  VCRAT SPREADSHEET

The VCRat spreadsheet can simulate the runoff from one subarea, create a hydrograph, adjust the hydrograph’s yield, and route the hydrograph through a detention basin. It can also calculate the required volume of a bypass basin if the user specifies the desired mitigation level.

Input to the spreadsheet is the same as the VCRat2.64 model except that it does not require channel routing data and cannot do diversions or calculate areal reduction factors. The spreadsheet was designed to use the iterative calculation option in Excel. This avoids having a spreadsheet with macros that cannot be used on some consultant networks due to IT concerns. Figure 4 shows the File→Options→Formulas setup for using the iterative calculations.

![Figure 4. Iterative Calculation Setup for VCRat Spreadsheet](image)

Figure 5 shows the data input section of the spreadsheet. The spreadsheet cells and calculation worksheets are locked except for the cells that are used for modeler data entry highlighted in blue. Once the data are entered, the calculation should automatically converge to a solution as shown by the Iteration Volume Difference of 0.00. If this difference is not 0.00, the F9 key should be pressed to trigger manual calculations until the difference becomes 0.00.

Figure 6 shows the chart providing the input and basin routed outflow hydrographs and mitigation levels set by the use. In this case the 10-yr developed condition was the desired mitigation goal. The goal was met by the basin stage-storage-discharge data entered in the Basin Routing Data cells.
**SECTION THREE**

### VCRat Spreadsheet

#### VCRat Single Subarea Hydrograph, Mitigation, and Detention Basin Routing Calculations

<table>
<thead>
<tr>
<th>Project Information:</th>
<th>Test Hydrograph, Ventura County</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DEVELOPED CONDITION INPUT DATA</strong></td>
<td></td>
</tr>
<tr>
<td>Watershed Area ac =</td>
<td>3.00 User Input</td>
</tr>
<tr>
<td>Time of Concentration Tc min =</td>
<td>20 User Input</td>
</tr>
<tr>
<td>% Imperviousness =</td>
<td>51 User Input</td>
</tr>
<tr>
<td>Land Use Description =</td>
<td>1/5 acRes User Input</td>
</tr>
<tr>
<td>Storm Zone =</td>
<td>Carpenteria Coastal Dropdown List</td>
</tr>
<tr>
<td>Storm Frequency =</td>
<td>25 Dropdown List</td>
</tr>
<tr>
<td>District Soil Number =</td>
<td>3Rev Dropdown List</td>
</tr>
<tr>
<td>NRCS Curve Number Yield in =</td>
<td>5.92 User Input</td>
</tr>
<tr>
<td><strong>MITIGATION INPUT DATA</strong></td>
<td></td>
</tr>
<tr>
<td>Mitigation Level =</td>
<td>10-yr Dev User Input</td>
</tr>
<tr>
<td>Time of Concentration Tc min =</td>
<td>25 User Input</td>
</tr>
<tr>
<td>Storm Frequency =</td>
<td>10 Dropdown List</td>
</tr>
<tr>
<td>% Effective Imperviousness =</td>
<td>51 User Input</td>
</tr>
<tr>
<td>Land Use Description =</td>
<td>1/5 acRes User Input</td>
</tr>
<tr>
<td><strong>CALCULATION RESULTS</strong></td>
<td></td>
</tr>
<tr>
<td>Iteration Volume Difference cf =</td>
<td>0.000</td>
</tr>
<tr>
<td>Dev. Subarea Outflow Peak cf =</td>
<td>5.21</td>
</tr>
<tr>
<td><strong>FLOW THROUGH BASIN RESULTS</strong></td>
<td></td>
</tr>
<tr>
<td>Basin Inflow Peak cf =</td>
<td>5.21</td>
</tr>
<tr>
<td>Mitigated Hydrograph Peak cf =</td>
<td>3.79</td>
</tr>
<tr>
<td>Routed Hydrograph Peak cf =</td>
<td>3.04</td>
</tr>
<tr>
<td>Max Basin Storage af =</td>
<td>0.1422</td>
</tr>
<tr>
<td>Max Basin Elevation ft =</td>
<td>3.40</td>
</tr>
<tr>
<td><strong>BYPASS BASIN RESULTS</strong></td>
<td></td>
</tr>
<tr>
<td>Inflow Hydrograph Peak cf =</td>
<td>5.21</td>
</tr>
<tr>
<td>Mitigation Hydrograph Peak cf =</td>
<td>3.79</td>
</tr>
<tr>
<td>Peak Flow into Bypass Basin cf =</td>
<td>1.42</td>
</tr>
<tr>
<td>Volume into Bypass Basin cf =</td>
<td>1.477</td>
</tr>
<tr>
<td>Bypass Basin Unit Volume cf/ac =</td>
<td>492</td>
</tr>
</tbody>
</table>

*Figure 5. VCRat Spreadsheet Data Input and Results Section*
Figure 6. Basin Hydrograph Routing Results
SECTION 4 VCRAT2.64 MODEL PREPARATION

The VCRat2.64 install package can be downloaded from the District’s website, and installed and launched. The resulting window is shown in Figure 7.

![Figure 7. VCRat2.64 Initial Window](image)

The first step is to use File → Save As and save the file in the work folder with the desired name. (Or open an existing file by File → Open. The program does not show you a list of recently opened files but remembers the location of the last file that was run and will show you the files in that folder with the Open option.)

4.1 PROJECT INFO WINDOW

Open the Project Info page also accessed through Model → Project Info and perform the following steps:

1. Enter in Project Name (Required!).
2. Enter up to 5 digit project number.
3. Enter Subarea Start Number.
4. Select the C Coefficient curve set you want to use- either the VCRat2.6 Legacy coefficients or the VCRat2.64 updated coefficients. If selecting the Legacy Curves, the four Rain Zones will be populated with the historic J Prime, K, and L Zones. If you need to use the historic J Zone, that is specified in another window discussed later.
5. Specify if you want to use a Relative Project Path so the output and hydrograph files will be stored in the same folder as the input file, or an Absolute Path where those files will be stored. If you want the output file to have a different name than the input file, specify that in the Model Results Report entry.

6. Specify the location of the file containing the Imported Hydrographs in that entry location.

7. Specify the primary storm frequency for the run with the Storm Frequency dropdown menu. If you want to use more than one storm frequency in the run, that option is turned on in another window.

8. Add as many single lines containing information about the project as you want to document. Each single line can contain up to 100 character but only 87 will be displayed in the window. The windows cannot be resized to display more characters.

Figure 8. Project Info Page with Legacy C Coefficients and Rainfall Zones Selected
Figure 9. Partial Project Info Window with Revised C Coefficients Selected

Figure 9 shows the Project Info Window with the revised C coefficients selected. With this choice, up to four rain zones can be selected for the run out of the 31 shown in the drop down menu that is displayed.

4.1.1 Tools ➔ Options Window

The Tool ➔ Options window has the following information:

1. Allows the user to specify that the program use the legacy J Zone rainfall instead of the default J prime zone rainfall.
2. Shows the default location for the VCRAIN.DAT input file that contains the rainfall mass curves and C coefficient data and allows the user to browse to a different file in a different location.
3. Specifies the text editor to use to view the output file and the formatting of the default landscape page for printing the results.
4. Allows the user to use different storm frequencies in the model run. Once this box is checked, you need to go back to the Project Info Window and check the “Allow Subareas to override storm frequency” box.

Figure 10. Options Window
4.2 **SUBAREA EDITING WINDOW**

To add subareas to a model, you must enter a project name in the Project Info Window. That activates the “Add” subarea button on the main window. Click “Add” to display the Add/Insert Operation Window and select the type of operation you want to use in the model as shown in Figure 11.

![Add/Insert a new Model Command/Operation Window](image1)

*Figure 11. New Model Command/Operation Window*

The first operation in any model can only be a simple subarea calculation with flow routing, a placeholder/dummy operation, or import of a hydrograph. If you intend to do a more complicated operation such as divert flow to a lateral or detention basin routing associated with a subarea, use a placeholder for the first operation and then select “Subarea” to use with those operations subsequently as shown in Figure 12.

![VCRat264ExampleFile - VCRat v2.6](image2)

*Figure 12. Partial Model Operation Subarea Window*
Double click on a model operation line in the “Model Commands” sub-window to open up an editing window as shown in Figure 13.

![Figure 13. Subarea Editing Window](image)

Enter in the subarea data. In this example the “Hydrograph Printout” box has been checked so the program will create a hydrograph output file that can be exported after the program runs. The Arroyo Las Posas Rain Zone has been selected from the 4 choices set in the Project Info Window. Soil type 4 has been selected and represented as 040 in the window.

### 4.2.1 Channel Routing

If channel routing is associated with this subarea, click the “Main Channel Routing Add/Edit” button to activate that editing window. The dropdown menu under “Routing Type” shown in Figure 14 gives seven choices from machine routing where the program picks the channel type to specifying a rectangular/trapezoidal channel with a fixed velocity and/or flow depth (Figure 15). Each routing type requires input data as shown in Table 2. Natural mountain channels are generally considered to have slopes greater than 5% with cobbles, where natural valley channels have lower slopes and channel
roughnesses. The VCRat program only uses 40-ft roads where the Tc Calculator uses 32- and 40-ft roads. Pipes use a default N value of 0.012.

Figure 14. Channel Routing Window and Channel Dropdown Menu

Figure 15. Rect/Trap Routing Window with Limits
Table 2. Channel Routing Parameters

<table>
<thead>
<tr>
<th>Type</th>
<th>Length</th>
<th>Slope</th>
<th>Width</th>
<th>Diam/</th>
<th>Auto Size</th>
<th>SideSlope</th>
<th>Side N</th>
<th>Bottom N</th>
<th>Max Vel</th>
<th>Max Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine</td>
<td>R</td>
<td>R</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Natural Mountain</td>
<td>R</td>
<td>R</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Natural Valley</td>
<td>R</td>
<td>R</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40-ft Wide Road</td>
<td>R</td>
<td>R</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pipe</td>
<td>R</td>
<td>R</td>
<td>O</td>
<td>O</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rectangular Open</td>
<td>R</td>
<td>R</td>
<td>O</td>
<td>O</td>
<td></td>
<td></td>
<td>R</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Trapezoidal Open</td>
<td>R</td>
<td>R</td>
<td>O</td>
<td>O</td>
<td>R</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Fixed Vel/Depth</td>
<td>R</td>
<td>R</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
</tbody>
</table>

R=Required; O=Optional

Concrete rectangular and trapezoidal channels use a default N value of 0.014. The program does not have the option to model a rectangular concrete box as it assumes open channel flow. Fixed depths lower than the program maximum of 13 ft can be applied to rect/trap channels. Fixed velocities can also be applied for use in modeling drop structures or other situations where the flows are controlled.

4.2.2 Use of Placeholders

The VCRat program output does not show the peak in the channel after any attenuation from channel routing unless the subarea operation is followed by a placeholder operation. Because VCRat uses wave velocity for routing the attenuation is fairly small unless it is a large channel with a long reach and low slope. An example of this is Camarillo Hills Drain adjacent to the airport with a reduction of 250 cfs for a flow of about 5,000 cfs. If routing effects may be significant, use as many placeholder operations as desired. One thing to remember is that the exported hydrograph for a subarea does not include the specified routing effects because the routing is assumed to occur through the next downstream subarea.

4.2.3 Detention Basin Routing

If there is a detention basin at the downstream end of the subarea, the detention basin editing window can be used to model the basin as shown in Figure 16. This example does not include areal reduction but “fattens” the hydrograph by specifying the subarea Curve Number and the 100-yr 24-yr rainfall depth. Then stage-storage-discharge points were added as well as spillway and dam elevation information.

One thing to note about detention basin routing is that if you specify a routing reach for the subarea, the program will use the routed flow as the input to the detention basin. If the routing is intended for the next subarea downstream of the basin, it should be added to the routing data section after the detention basin.
Enabling the detention basin operation will also enable the subsequent channel routing feature as shown in Figure 17.

![Figure 16. Detention Basin Routing with Fattening](image)

![Figure 17. Subarea Window with Post-Basin Routing](image)
4.2.4 Confluences

Confluences are used after adding a lateral to the model to join the lateral flow with the mainline flow. The confluence window requires the primary and lateral hydrograph bank letters, and allows the user to specify if they want a junction analysis and a hydrograph for export. The junction analysis will show the flow in the lateral at the time of the peak in the mainline, the flow in the mainline at the time of the peak in the lateral, and the time and peak of the combined flow.

![Confluence Editing Window](image1.png)

*Figure 18. Partial Confluence Editing Window with Hydrograph and Confluence Options*

4.2.5 Diversions

There are 4 types of diversions that can be used in VCRat as shown in Figure 19:

1. Case I - Specified percent of flow remains in main drain, excess is transferred to relief drain
2. Case Ia - Program compares drain peak to specified flow value (smaller than peak), calculates percent, and transfers flow above that percent to relief drain.

![Diversions Editing Window](image2.png)

*Figure 19. Partial Diversion Editing Window Showing Options*
3. Case II – Flow in excess of specified value to relief drain

4. Case III – Flow in excess of base (= peak - specified value) remains in channel, remainder to relief drain.

Case II is the type that is used most frequently in modeling diversions to bypass detention basins using a pre-calculated flow mitigation level. The other cases are used to model more complicated hydraulic diversion designs if appropriate.

4.2.6 Areal Reduction Simulations

An example of areal reduction is provided for the model shown in Figure 20.

![Partial Model Editing Window for Areal Reduction Example](image)

Figure 20. Partial Model Editing Window for Areal Reduction Example

The model is run normally and the VCRat2.2 input file is extracted from the bottom of the output file as shown below. A “1” is added to column 67 of the first 006 entry line as shown in red. Another “1” is placed in column 67 of the 006 entry line for node 007A to obtain AR results for that node. The last 999 line is deleted as VCRat2.2 input files do not use it. The file is then saved with a name using the 8.3 format such as ExampAR.99i.
For VCRat2.2, this input file produced a composite output file that provided the normal results up to the node where AR is specified, and then a second output section with areally reduced flows at all nodes. The areally reduced flow is only valid for the node where it was specified. Each node has to be evaluated with a separate model run. The design peak can be obtained directly from the AR run. For AR of the flow upstream of a basin, an ARF is calculated as AR Flow/Non-AR Flow and entered as input into the basin editing window in VCRat.

For VCRat2.6 and 2.64, the output only consists of the AR flow results. Currently the VCRat2.64 program will only do AR runs using the legacy mass curves. If AR results are required before VCRat2.64 is updated to provide AR results for the NOAA mass curves, then it is possible to revise the VCRAIN.DAT file to replace the B98 (K100) rainfall data with the appropriate NOAA mass curve.

### 4.3 VCRat Output

Figure 21 shows a typical VCRat output file. The subarea summary portion of the output file contains the following main elements:

1. Subarea data input and flow peak calculation results.
2. Effect of channel routing on flow results shown with addition of a placeholder.
3. Confluence and diversion results.

After the subarea results are presented, the time and flow ordinates for the nodes where hydrograph results were specified are provided. The detention basin routing results are also provided, including the basin routing summary, the stage-storage-discharge data, and the hydrographs for the various operations (inflow, areally-reduced, fattened, and basin outflow).

If the modeler specified a channel type at the start of the run, but did not provide a conveyance size, a “#” next to the channel type indicates that channel type was changed by VCRat to accommodate the calculated flow level. The different developed channel types in order of ascending capacity are 40-ft street, pipe up to 8 feet in diameter, and rectangular open channel.
## Section Four

**VCRat version:** 2.64.0.30  
**VCRain version:** 201601  
**DOS EXE version:** PC 2.64-201605  
**VCRain Curve Set:** VCWPD 2016 Revised Curve Set  
**Curve A:** CON3: Conejo Creek  
**Curve B:** CON2: NF/SB Arroyo Conejo - ASR  
**Curve C:** ALP1: Arroyo Las Posas  
**Curve D:** CARP1: Carpenteria Coastal

Ventura County Watershed Protection District  
Modified Rational Method Hydrology Program (VCRat v2.64)

### Model Results

<table>
<thead>
<tr>
<th>NODE</th>
<th>SOIL</th>
<th>RAIN</th>
<th>TC</th>
<th>%</th>
<th>AREA</th>
<th>FLOW</th>
<th>AREA</th>
<th>FLOW</th>
<th>TIME</th>
<th>CHANNEL</th>
<th>LENGTH</th>
<th>SLOPE</th>
<th>SIZE</th>
<th>H:V</th>
<th>N VALUES</th>
<th>VEL</th>
<th>DEPTH</th>
</tr>
</thead>
<tbody>
<tr>
<td>1A</td>
<td>030</td>
<td>A100</td>
<td>5</td>
<td>20</td>
<td>50</td>
<td>119</td>
<td>50</td>
<td>119</td>
<td>1153</td>
<td>PIPE</td>
<td>2000</td>
<td>0.01000</td>
<td>3.75</td>
<td>----</td>
<td>-----</td>
<td>----</td>
<td>----</td>
</tr>
<tr>
<td>2A</td>
<td>---</td>
<td>---</td>
<td>--</td>
<td>--</td>
<td>---</td>
<td>---</td>
<td>50</td>
<td>96</td>
<td>1157</td>
<td>-------</td>
<td>----</td>
<td>-------</td>
<td>---</td>
<td>----</td>
<td>-----</td>
<td>----</td>
<td>----</td>
</tr>
<tr>
<td>3B</td>
<td>030</td>
<td>B100</td>
<td>5</td>
<td>20</td>
<td>50</td>
<td>130</td>
<td>50</td>
<td>130</td>
<td>1153</td>
<td>-------</td>
<td>----</td>
<td>-------</td>
<td>---</td>
<td>----</td>
<td>-----</td>
<td>----</td>
<td>----</td>
</tr>
</tbody>
</table>

**4AB:** Confluence A and B lines

4AB:  
<table>
<thead>
<tr>
<th>NODE</th>
<th>SOIL</th>
<th>RAIN</th>
<th>TC</th>
<th>%</th>
<th>AREA</th>
<th>FLOW</th>
<th>AREA</th>
<th>FLOW</th>
<th>TIME</th>
<th>CHANNEL</th>
<th>LENGTH</th>
<th>SLOPE</th>
<th>SIZE</th>
<th>H:V</th>
<th>N VALUES</th>
<th>VEL</th>
<th>DEPTH</th>
</tr>
</thead>
<tbody>
<tr>
<td>4AB</td>
<td>---</td>
<td>---</td>
<td>--</td>
<td>--</td>
<td>50</td>
<td>130</td>
<td>100</td>
<td>187</td>
<td>1153</td>
<td>PIPE</td>
<td>1000</td>
<td>0.01000</td>
<td>4.50</td>
<td>----</td>
<td>-----</td>
<td>----</td>
<td>----</td>
</tr>
</tbody>
</table>

5A: Split off 10% of flow into lateral  
7AF: Control/Diversion: 90% to channel A

**7AF:**  
<table>
<thead>
<tr>
<th>NODE</th>
<th>SOIL</th>
<th>RAIN</th>
<th>TC</th>
<th>%</th>
<th>AREA</th>
<th>FLOW</th>
<th>AREA</th>
<th>FLOW</th>
<th>TIME</th>
<th>CHANNEL</th>
<th>LENGTH</th>
<th>SLOPE</th>
<th>SIZE</th>
<th>H:V</th>
<th>N VALUES</th>
<th>VEL</th>
<th>DEPTH</th>
</tr>
</thead>
<tbody>
<tr>
<td>7AF</td>
<td>---</td>
<td>---</td>
<td>--</td>
<td>--</td>
<td>---</td>
<td>---</td>
<td>150</td>
<td>289</td>
<td>1154</td>
<td>-------</td>
<td>----</td>
<td>-----</td>
<td>----</td>
<td>----</td>
<td>-----</td>
<td>----</td>
<td>----</td>
</tr>
</tbody>
</table>

8A: Basin Routing  
8A: No AR, fattening applied  

**INCOMING HYDROGRAPH PEAK (cfs):** 288.94  
**VOLUME (acre-ft):** 22.98  
**NO HYDROGRAPH ADJUSTMENT**  
**RUNOFF FACTOR (in):** 3.94  
**TOTAL RAIN (in):** 7.00  
**SCS Curve:** 73

**FATTENED HYDROGRAPH PEAK (cfs):** 321.05  
**VOLUME (acre-ft):** 49.24  
**RESERVOIR INFLOW:**  

INCOMING HYDROGRAPH PEAK (cfs): 288.94  
VOLUME (acre-ft): 22.98

INCOMING HYDROGRAPH PEAK (cfs): 288.94  
VOLUME (acre-ft): 22.98

INCOMING HYDROGRAPH PEAK (cfs): 288.94  
VOLUME (acre-ft): 49.24
**SECTION FOUR**

* MAXIMUM ELEVATION: STAGE (ft): 9.38 @ 1161 VOLUME (acre-ft): 4.63 *
* EMERGENCY SPILLWAY: ELEV (ft): 5.00 VOLUME (acre-ft): 2.00 *
* DIFFERENCE: IN STAGE (ft): +4.38 IN VOLUME (acre-ft): -2.63 *
* SPILLED FROM 1120 TO 1216 FOR 97 MINUTES *
* TOP OF DAM: ELEV (ft): 10.00 VOLUME (acre-ft): 5.00 *
* DIFFERENCE IN STAGE (ft): -0.62 IN VOLUME (acre-ft): 0.37 *
* NO OVERTOP EXPECTED. PERCNT OF VOLUME REMAINING TO TOP OF DAM: 7.4% *
* RESERVOIR OUTFLOW: PEAK (cfs): 185.01 @ 1161 VOLUME (acre-ft): 46.49 *

********************************************************************************************

8A   ---   ---    --   --    ---    ---      150     185   1161    -------    ----  -------    ---     ----    -----  -----    --     --
9A   ---   ---    --   --    ---    ---      150     185   1161    -------    ----  -------    ---     ----    -----  -----    --     --

**Figure 21. Partial VCRat2.64 Output File**
SECTION 5 DESIGN PROCEDURES AND TOPICS

This section summarizes the detailed information presented in Section 6 of the Hydrology Manual.

5.1 UPDATED MPD DATA

Most of the Cities have relatively recent Master Plans of Drainage (MPDs) to evaluate their local storm drain systems and plan for system upgrades. For small projects, the MPD or available District Hydrology Models can be used to obtain Tc’s and calculate runoff peaks as described in Section 5.2. The MPDs provide both the 10- and 100-yr Tc’s for use in studies.

5.2 UNIT RUNOFF CALCULATIONS FOR SMALL PROJECTS

When development projects consist of small areas that do not meet the Hydrology Manual minimum subarea size of 5 ac, it is possible to estimate the change in peak flows from the project area using pro-rated values based on the unit runoff. The steps are as follows:

1. Find the subarea that incorporates the project area in a city Master Drainage Plan or official District VCRat hydrology model.

2. Evaluate if the change in development for the project would affect the subarea Tc by more than 0.5 minutes (VCRat only accepts Tc’s rounded to the nearest minute). Unless the project is located in the upper portion of the subarea and would affect the overland flow portion of the Tc, the Tc is not likely to change. If the Tc does not change, the corresponding intensity used in the subarea peak flow calculation does not change. If the Tc does change, recalculate it to obtain the correct design storm intensity for use in peak flow calculations (Exhibit 2 of Design Hydrology Manual).

3. Find the C coefficient for the pre- and post-development conditions (Exhibit 6 of Hydrology Manual), and recalculate the peak flows from the project area only.

4. If the pre-or post-developed condition percent imperviousness matches that used in the model subarea, the peak can be obtained from the model result through pro-rating based on area.

5. Sometimes the increase is runoff is very small but the District has been concerned about the cumulative increase in flow due to numerous small projects and so has been asking for mitigation for any new project with very limited exceptions. Even when the increase in peak is small, the increase in runoff volume can be significant.

6. If a detention basin is selected to provide mitigation, the VCRat model can be used for its design. Simplified methods for designing detention areas for very small projects are provided in following sections.

An example of this method is provided in Appendix B of the Hydrology Manual.

For this iteration of the Hydrology Manual, the District has developed several spreadsheets to assist consultants with small projects. The spreadsheets include the following:

1. Tc Calculator spreadsheet that calculates the time of concentration for one subarea after the user enters in the required subarea and flowpath information.
2. VCRat spreadsheet that calculates the flow hydrograph for one subarea, adjusts the yield, and routes it through one flow-through detention basin using the provided stage-storage-discharge data. The spreadsheet also calculates the required bypass detention basin volume to store the runoff volume occurring above a specified mitigation peak level.

These spreadsheets are provided in Appendix E of the Hydrology Manual. The user interface portions of the spreadsheets are shown in Appendix A of the Hydrology Manual.

5.3 DESIGN STORM MULTIPLIERS

Currently, the Tc calculator has been automated so that it is relatively easy to calculate Tc’s for all design storms of interest once the subarea Tc physical data have been entered into the calculator. The current Hydrology Manual now provides the 24-hr rainfall depths for the 10-, 25-, 50-, and 100-yr storms. Therefore, there is no longer a need to use the Hydrology Design Storm Multipliers in design calculations using the VCRat model except in limited special cases. Exhibit A-21 in the Hydrology Manual provides the updated multipliers developed by the District if it is necessary to use them.

5.4 TIME OF CONCENTRATION CALCULATIONS

The current Tc calculator program automatically does the iterations necessary for the calculation and therefore greatly decreases the time necessary for a single Tc. Also, the program makes it easy calculate Tc’s for all design storm levels once the Tc input data file is generated. Because of these factors, currently the hydrologist is required to calculate Tc’s for 75 percent of the developed subareas and 25 percent of the undeveloped subareas included in the hydrologic model. Engineering judgment can be used to estimate Tc’s for the other subareas as long as they are hydrologically similar in slope and development type to the subareas with calculated Tc’s.

The MPD models provide Tc's and peaks for the 10- and 100-yr storms. Tc’s for the 25-yr and 50-yr storms can be estimated using the 10- and 100-yr data points.

5.5 BULKING FACTORS

The hydrology model results generated by the VCRat2.2, 2.6, and 2.64 models are considered clear water estimates. Bulking factors are generally not required for development projects results except for projects near critical infrastructure or emergency projects designed to mitigate damage due to recent fires in the watershed. If these are issues for a project, the Hydrology Manual provides a detailed discussion of the District’s Bulking Factor methods.

5.6 CHANGE IN RUNOFF PARAMETERS DUE TO FIRE

The District does not have a policy to increase C coefficients in VCRat to account for fire effects.

5.7 FLOW LIMITATION AGREEMENTS, CITY OF OXNARD

The District’s Rice Rd Drain jurisdictional channel in the City of Oxnard has been subject to upstream development. Because the increase in runoff has increased the flooding potential in downstream areas, the District and the City of Oxnard developed an agreement that limited the runoff from new development to specified limits. Agreement FC-2-87-6A limited the peaks from new development for the 100-yr storm
to 1 cfs/ac north of Fifth Street and to 0.72 cfs/ac for the portion of the watershed between Fifth Street and Emerson Avenue.

5.8 BYPASS BASIN DESIGN

Some Cities have required consultants to use a volume of 1,000 cf/ac of development to size their bypass basins based on historical data. Outflow from the basin was controlled by an orifice plate sized to limit the discharge to the 10-yr developed condition peak based on the assumed depth of the basin.

The 1,000 cf/ac number is no longer valid. The correct volume for bypass basins can be obtained through analyses using the updated VCRat2.64 program or the VCRat one-subarea spreadsheet that also calculates the bypass basin volume based on the user-specified mitigation level.

5.9 FLOW-THROUGH BASIN DESIGN

The District has not attempted to produce a nomograph that could be used for flow-through basin design by consultants because there are so many parameters associated with routing of flow through a basin, including hydrograph shape, operating spillway design, low flow outlet design, 100-yr 24-hr rain depth, subarea percent imperviousness, and Tc’s and C coefficients for the VCRat program. The volume for basins can be obtained through analyses using the updated VCRat2.64 program or the VCRat one-subarea spreadsheet that also calculates the flow-through basin volume based on the user-specified mitigation level. VCRat hydrographs can also be exported for use in another program that has automated design features.

5.10 SIMPLIFIED BASIN DESIGN PROCEDURES FOR SMALL PROJECTS

For consultants or permit applicants that are only developing or modifying a small project area, the District has developed a set of simplified procedures to size detention facilities. The results of the procedures are relatively conservative when compared to designs using full basin routing analyses. Therefore, they are only used when the small size of the project does not warrant a more sophisticated analysis. Projects of 5 ac or more can be evaluated with the VCRat program. Projects with only one subarea of any size can be evaluated with the spreadsheet.

5.10.1 100-Yr Undeveloped Condition Peak Mitigation

Estimates of the detention volume required for projects to mitigate from the 100-yr developed to the 100-yr undeveloped condition can be obtained with a NRCS Curve Number evaluation of the additional impervious project area as follows:

1. Find 100-yr 1-day rainfall for project area from Appendix E maps or GIS shapefiles provided with Hydrology Manual.
2. Find CNs associated with undeveloped and impervious project conditions from Hydrology Manual Exhibit 14,
3. Find runoff depths in inches from Exhibit 13 or use equation provided on Manual Exhibit 13.
4. To find net yield, subtract additional 0.5 inch for additional depression storage and abstractions so that result is more consistent with the District’s detention basin routing results.
5. Multiply runoff depths in feet by impervious area of project in square feet to obtain the undeveloped and developed runoff volumes.

6. This volume will generally be larger than that obtained through a routing and design analysis of the basin using a yield-adjusted VCRat hydrograph because the routing effects generally reduce the required basin size. The volume may also be larger than that required by reducing the peak back to the 10-yr developed level below due to the CNs used.

An example calculation is provided in Table 3.

### 5.10.2 10-Yr Developed Peak Mitigation Criteria

For small project areas with mitigation requirements that the 100-yr developed peak should be reduced to the 10-yr developed peak, the following approach has also been used:

1. Find the 100-yr 1-day rain depth for project site.
2. Find the 10-yr 1-day rain depth for project site
3. Subtract the two plus an additional 0.5 in for depression storage
4. Multiply by impervious area with units in cubic feet

An example of this technique is shown in Table 4.

### Table 3. Simplified Basin Based on Impervious Area

<table>
<thead>
<tr>
<th>Watershed Data</th>
<th>Undeveloped</th>
<th>Impervious</th>
</tr>
</thead>
<tbody>
<tr>
<td>100-yr 1-d Rain (inch)</td>
<td>7.6</td>
<td>7.6</td>
</tr>
<tr>
<td>Soil Type</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Land Use</td>
<td>Open Space</td>
<td>Imperv area</td>
</tr>
<tr>
<td>CN Exhibit 14</td>
<td>73</td>
<td>98</td>
</tr>
<tr>
<td>S = 1000/CN-10</td>
<td>3.70</td>
<td>0.20</td>
</tr>
<tr>
<td>Yield (inch) from Exhibit 13</td>
<td>4.46</td>
<td>7.36</td>
</tr>
</tbody>
</table>

**Volume Calculation**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Yield Difference in</td>
<td>2.90</td>
</tr>
<tr>
<td>Additional Assumed Depression Storage Impervous Surfaces (inch)</td>
<td>0.50</td>
</tr>
<tr>
<td>Net Yield (inch)</td>
<td>2.40</td>
</tr>
<tr>
<td>Impervious Area (ac)</td>
<td>0.0500</td>
</tr>
<tr>
<td>Vol Increase - Max. Basin Size Req'd (cf)</td>
<td>436</td>
</tr>
</tbody>
</table>
Table 4. Simplified Basin Volume Based on Storm Depth -

<table>
<thead>
<tr>
<th>Volume Calculation</th>
<th>100-yr 24-Hr Depth</th>
<th>10-yr Depth</th>
<th>24-Hr Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rainfall (inch)</td>
<td>7.6</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Yield (inch)</td>
<td></td>
<td>2.6</td>
<td></td>
</tr>
<tr>
<td>Depression Storage Impervious Surfaces (inch)</td>
<td></td>
<td>0.50</td>
<td></td>
</tr>
<tr>
<td>Net Yield (inch)</td>
<td></td>
<td>2.10</td>
<td></td>
</tr>
<tr>
<td>Impervious Area (ac)</td>
<td></td>
<td>0.0500</td>
<td></td>
</tr>
<tr>
<td>Vol Increase - Max. Basin Size Req'd (cf)</td>
<td></td>
<td>381.2</td>
<td></td>
</tr>
</tbody>
</table>

5.10.3 VCRat Hydrographs for Small Projects

The minimum subarea size in VCRat 2.6 and 2.64 is 5 ac to decrease the chances of the program being used to produce design flows for numerous tiny subareas such as is commonly required for drainage design. Small projects with one subarea can be evaluated using the VCRat spreadsheet. However it is possible to use the program to get a hydrograph for a small subarea. The procedure takes advantage of the fact that the VCRat results are linear with area, so that the hydrograph of a 10-ac subarea is identical to the hydrograph of a 100-ac subarea divided by 10 as long as the other model input parameters (Tc, % impervious, soil type) are identical. The procedure to get a hydrograph for a 1.3 ac site is as follows:

1. Per the previous MPD discussion, find the subarea Tc applicable to the project area from an existing model or calculate one. Set up a model using the desired model rain zone and Tc and project area soil type and % imperviousness. For subarea size in the model, use the project area times a factor from 10 to 100. For this example, use a factor of 10 so the subarea size will be 1.3 x 10 = 13 ac.

2. “Fatten” the project area hydrograph using the yield adjustment procedure described in this manual.

3. Export the project area hydrograph in csv format so it can be imported into Excel. Divide the hydrograph ordinates by 10. The resultant hydrograph can be used in another program to do basin design for the project area.

4. Alternatively, use the flow split option in VCRat to split off 90% of the flow into a lateral, leaving 10% or 1/10th of the hydrograph in the mainline for use in designing a basin.

An example of this technique is shown in the Hydrology Manual Appendix B-12.
SECTION 6 REFERENCES


